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EDITOR
FR

O
M

    
 T

H
E Here at Kelby Media Group, we know that Lightroom is all about 

editing your photos to make them look their best and sharing them 
with everyone else. That’s why we always include a “Featured Pho-
tographer” in each issue—something to help get the creative ideas 
flowing and, honestly, to inspire you with some of the work of other 
photographers. It’s my pleasure to include one of my good buddies, 
Chris Orwig, in this issue. Chris is one of those guys who’s insanely 
inspiring, so I hope you’ll check out his work here and visit his web-
site at ChrisOrwig.com to see more of his images. 

Next up, the Lightroom preset frenzy continues. Our feedback shows that people absolutely 
love their presets, so we brought Sean McCormack back to write another article on going 
deeper into presets when editing your photos. Also, importing and organizing in Lightroom 
seems to always be a hot topic, so I wrote “Importing 101,” an article where we basically take 
you through the import process from scratch. 

When it comes to the Develop module, Nicole S. Young wrote about the new Radial Filter in 
Lightroom. Our “Before and After” video shows how to use Lightroom with Photoshop to 

edit your photos as smart objects so you can get the best dynamic range out of a single expo-
sure. We’re also psyched to have Lightroom guru, Laura Shoe (LauraShoe.com), in this issue. 
She tackles the bit-depth topic and writes about how best to set up Lightroom and Photoshop 
to get the most out of your photos. And if you’re one of the many fans of Seán Duggan’s 
“Tips & Tricks,” he’s back with more, so make sure you check them out. 

When it comes to showing off and sharing your photos, Scott Kelby continues his series on the 
Book module and how to get the best photo book possible. Varina Patel dives into the Publish 
Services panel and shows how to set up the new SmugMug plug-in so you can get your pho-
tos directly from Lightroom to your SmugMug website. As a side note, SmugMug just released 
some brand-new portfolio designs and they absolutely rock. Seriously, they’re stunning and if 
you’re a SmugMug member, you need to check them out. 

We couldn’t produce this magazine without you, so thanks for checking it out. If you like what 
you see, please help us spread the word. If you have ideas for articles, writers, tutorials, videos, 
presets, or anything else, feel free to drop me an email at lightroom@photoshopuser.com.

Matt Kloskowski 
Editor-in-Chief

M A T T  K L O S K O W S K I
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          THE 
LIBRARY
MODULE

ONE OF THE MOST IMPORTANT THINGS 

IN LIGHTROOM IS STARTING OFF ON THE 

RIGHT FOOT BY HAVING A CONSISTENT 

PROCESS FOR IMPORTING YOUR PHOTOS, 

AND I WANT TO BEGIN WITH A SUGGES-

TION THAT’S HELPED A LOT OF PEOPLE IN 

MY SEMINARS. 

IMPORTING 101 

GET ORGANIZED:

B Y  M A T T  K L O S K O W S K I
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One question I’m asked quite often is how to import older photos 
that are scattered among multiple drives, or even worse, photos 
that exist in another program such as iPhoto or Aperture. There’s 
really no trick to it other than following the steps here (especially 
Step One) and starting from scratch. One thing I always suggest, 
however, is this: If these photos aren’t crucial to your everyday 
work and you don’t need to have instant access to them, consider 
only importing new photos into Lightroom going forward. Maybe 
save a folder of all of your favorite photos and import that into 
Lightroom, but leave the others as they are. You may end up doing 
a ton of work for photos that you don’t refer back to very often. 
It’s just a suggestion, but I’ve had many people tell me that this 
saved them from many hours of work. Okay, now that’s out of the 
way, let’s get started.

The first thing to do is come up with a consistent way to store your 
photos on your hard drive. I keep it pretty simple: I create a folder 
called Photos. The name you choose doesn’t matter; you could 
call it My Photos, Lightroom Photos, or anything that makes sense 
to you. Then, inside that folder I’ll store all of my photo shoots or 
projects in subfolders, which will be created in Lightroom during 
the import process (more on that later). The entire structure looks 
something like the image here. If you have older photos that you 
want to bring into Lightroom, then I’d suggest organizing them 
like this before you even open Lightroom to help make things 
easier down the road.

When you’re ready to bring your photos into Lightroom, go to 
File>Import Photos and Video to open the Import dialog. There’s 
a preference in Lightroom that will automatically open the dialog 
when it detects a card reader or certain drives with photos on 
them (such as your phone). In case you want to turn this prefer-
ence off or back on, go to Lightroom (PC: Edit)>Preferences, and 
under the General tab, you’ll see the option to Show Import Dia-
log When a Memory Card Is Detected.

STEP ONE

STEP TWO
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Once you’re in the Import dialog you’ll see a Source panel on 
the left. This is where your photos are coming from. For new 
photos, the source will most likely be a card reader that you 
have connected. But if you’re importing older photos that are 
already on your computer or a connected hard drive, then use 
the left side to navigate to that folder with the photos you 
want to bring in.

 

Then next step is to choose what you want to do with the 
photos. You’ll see a few options at the top (Copy as DNG, 
Copy, Move, and Add). You really only need to worry about 
two of them. If you’ve just taken the photos and they’re on a 
memory card, then chances are you’re always going to use the 
Copy option to copy them somewhere. If they’re photos that 
you’ve already put on your computer or another external hard 
drive, and they’re already stored where you want them, then 
you’ll use the Add option because it simply leaves them where 
they are, but makes Lightroom aware of them. For now, let’s 
assume we’re bringing in photos already on the computer (or 
an attached hard drive), so choose the Add option. 

STEP THREE

STEP FOUR
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Now we move over to the right side. Remember, this is “Import-
ing 101,” so we’re not going to exhaustively go through every 
setting here. I just want to get you up and running with your 
import process, so we’ll cover the main options. First, under File 
Handling, is Render Previews. This tells Lightroom what size of a 
preview to build for the photos as it imports them (these are the 
JPEG previews that are embedded automatically in your images). 
I’d suggest you choose Minimal as a beginner. It’s fast and it gets 
you looking at your photos pretty quickly. Keep in mind that if you 
decide to zoom in on a photo, you’ll have to wait a few seconds 
for Lightroom to build a larger preview.

A new feature in Lightroom 5 is smart previews. If you’re storing 
your photos on an external hard drive and you want to be able to 
work on those photos without the hard drive attached, then turn 
on the Build Smart Previews option. But if you’re working off of an 
internal hard drive or your photos are always on a drive attached 
to the computer, then leave it off. [For more on smart previews, 
see “Get Organized,” Lightroom Magazine, Issue #6, p. 6.—Ed.] 

Next, go to the Apply During Import panel. The only thing I change 
here is Metadata. Select New from the drop-down menu, and 
add your copyright, website, email, and contact info. This info is 
embedded into your photos during the import process, so it will 
always travel along with your photos. 

STEP FIVE

STEP SIX

STEP SEVEN
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STEP EIGHT

STEP NINE

That’s pretty much it for importing if you’re bringing in photos 
that are already on the computer or on an attached hard drive. 
But if you’re bringing in new photos from a card reader, then 
start by clicking the Copy option at the top. The main (and 
most important) thing you’ll see different is that there’s now a 
Destination panel on the right side. 

Note: There’s also a Copy as DNG option. DNG is a RAW file 
format created by Adobe, and Lightroom has a lot of new fea-
tures that support DNG, so it’s worth checking out. You can 
find more over at http://kel.by/19Z2llK.

We’re going to copy our photos into subfolders with descrip-
tive names that will help us find them later (you can also use 
dates if you prefer, but I’d suggest a descriptive name instead). 
So your first step in the Destination panel is to turn on the Into 
Subfolder checkbox and give your folder a descriptive name. 
Below that, under Organize, choose the Into One Folder option.
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STEP TEN

STEP ELEVEN

Remember back in Step One when we created that top-level 
folder called Photos? Well now all you have to do is tell Light-
room that’s where you want to store these photos. All of your 
connected drives will be listed in the Destination panel, so locate 
the drive you want the photos on (it could be an external drive 
if you’d like), then choose the Photos folder that you created on 
that drive back in Step One. When you click on that Photos folder, 
the subfolder you created in the last step will appear in italics with 
a little + icon, showing you where the photos will end up. Light-
room will automatically create this folder on your hard drive when 
you import the photos.

That’s it. You’re ready to do the import. You can always uncheck 
any photos you don’t want to import in the preview area of the 
dialog, but other than that, just click the Import button and your 
photos will start showing up in Lightroom. If you look over on the 
left side of the Library module in the Folders panel, you’ll even see 
the folder that has your photos in it listed there. n

ALL PHOTOS BY MATT KLOSKOWSKI[ 
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USING  
PRESETS  

AS BUILDING 
BLOCKS

TH
EBEHINDPRESETS

B Y  S E A N  M C C O R M A C K

LAST ISSUE, WE TALKED ABOUT PARTIAL 

PRESETS, OR BUILDING-BLOCK PRESETS. 

THESE PRESETS ALLOW US TO ADD EXACT 

CHANGES TO OUR PHOTO WITHOUT MESS-

ING WITH SETTINGS THAT WE’VE ALREADY 

MADE. I SEE THESE AS TWO TYPES OF PRE-

SET: TOOLS AND LOOKS.
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A tool preset is generally based on one slider from the Basic panel and 
is used with the Navigator panel to give a preview of the effect. A set 
of presets of the same slider at different amounts means you can view 
changes across a range of increments from that slider. For example, if 
we create presets for the Exposure slider at 1/3-stop increments rang-
ing from –2 stops to +2 stops, we’ll have 13 presets to show us what 
that whole exposure range looks like without applying any setting. To 
save each preset, click on the Create New Preset icon (+) at the top 
right of the Presets panel. In the New Develop Preset dialog, select 
only Exposure and Process Version. Give each preset a name, and click 
the Create button.

This might seem a little much, and it would be if we did this for every 
slider in the Basic panel, but there are a few that are definitely useful 
to have as presets. So let’s make them.

[To save you some time, all the presets discussed from this point on 
can be downloaded from http://photoshopuser.com/lightroom-app-
support. To install them, Right-click on any preset in the Develop 
module, and choose Import. Go to where you unzipped the down-
load, and choose the presets to add them to the Develop module.]

TOOL 
PRESETS

By hovering over Exposure presets, I can see that 2/3 stop is perfect for this photo
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The before and after on our example photo

With Process Version 2012, the Highlights and Shadows sliders allow us to create a tone-mapped look in 
Lightroom. For a preview set using these sliders, we can make presets at equal but opposite settings. For each 
preset, we’ll start with increments of 25 (i.e., –25 Highlights, +25 Shadows; –50 Highlights, +50 Shadows; 
etc.), and go up to 100. The Preset is saved with only Highlights, Shadows, and Process Version selected.

Our Basic panel settings  
and the corresponding New  

Develop Preset dialog

Next, make sets for both Clarity and Vibrance. In this case, we’ll go for positive Clarity and Vibrance. 
Again, we’ll go in increments of 25 for each. Vibrance at 100 is probably way too much, but we’ll use 
it anyway. You may prefer to use lower initial increments, such as 10, 20, 30, 40, 50, then 75 and 100. 
Other potential candidates for these tool presets include Contrast and Saturation.

To use the tool presets, first set a good Exposure for the photograph. It may be great out of the camera 
or it may need a tweak first. Next, hover over the HDR presets and preview them in the Navigator panel. 
For our photo, the strongest one works well (–100 Highlights, +100 Shadows). Then, hover over each 
Clarity preset. The second one works for this this photo (+50). Finally, repeat for Vibrance. While it’s really 
quite strong, I like the +75 preset for this. 
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LOOKS 
PRESET

The Radial Filter completes the look 

A Radial Filter inside the balloon 
with 1/2 stop of Exposure com-
pletes the look; we do need to 
add a little Saturation to the Radial 
Filter, though, as the Exposure 
washes out the color slightly. We 
could save the Radial Filter as pre-
set, but I think it’s too image spe-
cific in this case.

The second type of partial preset is the looks preset. These make changes beyond 
the Basic panel and generally affect the tone of the image. In the previous issue, we 
used the Tone Curve to fade a photo, making a big change to the look of the photo. 
Don’t worry, we’ll do it again, and add more to it.

For these, we’ll go with a fashion image with hats by Fiona Mangan Millinery. To cre-
ate a fade, go to the Tone Curve panel. If you see sliders in the panel, click the Point 
Curve icon at the bottom right of the panel. Make sure the Point Curve drop-down 
menu is set to Linear and the Channel drop-down menu is set to RGB. Click-and-
drag the bottom left point up the left axis of the curve. Save this as a preset with only 
Tone Curve selected. You can now add this curve to any image without affecting 
other settings (bar the Tone Curve obviously). 

The before and after for our fade
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If you want to have the option of using the fade with other 
Tone Curve settings, it’s best to create two versions: one with 
and one without the fade. It would be nice if Lightroom allowed 
additive presets, so you could add to the current Tone Curve 
and Graduated and Radial Filters, for example, but it doesn’t. 

Since this is a fashion image, I’m going to create a few differ-
ent toning looks. A new trick I recently learned was to increase 
contrast in the channels by moving the end points to crush the 
dark parts of the image, or even the highlights. To reset the 
curve, change the Point Curve drop-down menu from Custom 
back to Linear. Note that you can also save custom curves inside 
the Point Curve drop-down menu. 

The idea here is to push the high and low points. You’ll get a 
more precise idea looking at the presets (which come with the 
issue). One point to make is that Lightroom displays the input 
and output as percentages as you drag the curve, whereas the 
points are stored in the preset on a 0–255 scale. I wish it were 
0–255 in Lightroom itself to make it more like Photoshop. 

Anyway, click the Channel drop-down menu and choose Red. 
For this channel, push the left point up the left axis (0.0/8.6%), 
and the right point down the right axis (100/92.5%). Now 
choose the Green channel and drag the left point toward the 
right along the bottom axis (7.1/0.0%), with the right point 
coming down the right axis (100/97.6%). Finally, for the Blue 
channel, roughly copy the settings from the Red channel 
(0.0/8.6% and 100/92.9%). There’s nothing to stop you from 
trying different versions of this—that’s the point. Find some-
thing you like and save it as a preset. Let’s finish this by adding 
a fade to the RGB channel, because I liked it when we did it 
earlier. Save the preset as “Fashion 1.”

By subtly altering the points on the curves, we can create another 
look. Check out the settings for the next image (again there’s a 
fade on the RGB channel). To match our previous preset, we’ll 
call this “Fashion 2.” (By way of sample, you’ll find a Fashion 3 
preset in the downloads for you to get more ideas from.)

The settings for the individual Red, Green, and Blue channels

Fashion 2 curve settings 

The final look 

Fashion 2 look
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SPLIT TONE PRESETS
Another tool for changing the look of a photo is split toning. 
Split toning applies different tones to the highlights and shad-
ows in an image. It also allows the balance between highlights 
and shadows of that toning to be set. The next preset we’ll 
make does double duty. It warms the image if it’s in color, or 
creates a sepia tone if it’s black and white.

Open the Split Toning panel. We have two options for seeing 
what the Hue sliders are doing. The first is to hold the Option 
(PC: Alt) key and drag the Hue slider. As it moves, we preview 
the Hue at full Saturation. The other option is to set a low to 
medium Saturation and then move the Hue slider to taste. For 
a warm or sepia tone, somewhere between the reds and yel-
lows is good (around 30–40), with Saturation set to taste. In 
this case, it works best in the Shadows. Save the preset with 
only Split Toning ticked. 

The Split Toning panel settings The original image

The color photo with the preset applied A black-and-white version of the photo with the preset applied
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So those are the two types of partial presets. The beauty of creating presets like this is that each 
preset can be applied to any photo to build and change looks. With our fashion photo, we can 
apply our HDR, Vibrance, Clarity, Tone Curve, and Split Toning presets to get a whole new look. 
Simply hover over each preset, check how it looks in the Navigator, and apply the one that suits the 
image best. Easy. n

A whole new look from applying our presets 

ALL PHOTOS BY SEAN MCCORMACK
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          THE 
DEVELOP
MODULE

AMONG THE NEW FEATURES RELEASED 

IN LIGHTROOM 5, THE RADIAL FILTER 

WAS THE ONE I HAD BEEN HOPING FOR 

THE MOST. LIGHTROOM HAS HAD LIN-

EAR GRADIENTS FOR SOME TIME, BUT 

I’VE HAD MANY OCCASIONS WHEN THIS 

STRAIGHT-LINED FILTER JUST DIDN’T CUT 

IT. TO GET YOU STARTED WITH THIS NEW 

FEATURE, HERE ARE SOME TIPS, TRICKS, 

AND WAYS I USE THE RADIAL FILTER.

 THE  
RADIAL
FILTER  

PICTURE PERFECT:

B Y  N I C O L E  S .  Y O U N G
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Before you start using the Radial Filter, there are a few features 
and settings you need to be aware of. To access the Radial Filter, 
press Shift-M or click the circle icon in the Toolbox above the 
Basic panel.

Process Version: First of all, if you want to have full-function of 
this filter, your photos must be in the 2012 (Current) process 
version in the Camera Calibration panel. If you have it set to an 
older process version, then you won’t have half of the sliders to 
play with when adjusting your filter. 

Invert Mask: There’s one important checkbox in the Radial Filter 
panel that you’ll probably change quite often: the Invert Mask 
setting. When you apply a Radial Filter, the adjustments will 
appear on the outside of your oval or circle shape. If you’d like 
to do anything other than a vignette-type effect, then this will 
need to be checked. Unfortunately, it’s not sticky (meaning you 
can’t default it to being checked all the time), so you’ll have 
to make that extra mouse click each time you use the filter for 
nonvignette effects. You can also press the Apostrophe key (’) on 
your keyboard to turn the Invert Mask option on and off. 

GENERAL TIPS  
AND TRICKS 

When Process is set to 2012 (Current) in the Camera Calibration panel, you’ll 
have full use of the Radial Filter.

If Process is set to an older version, such as 2010, then you’ll lose many of the 
sliders in the Radial Filter.
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There are many ways to adjust the color of your images in Light-
room, and the Radial Filter is one more method of stylizing or 
balancing the overall look of a photograph. I’ve found that it’s a 
good way to add a burst of color, subtle contrast, or color haze 
to an image outside of the standard color and tone adjustments.

Photo filters: You can use the Radial Filter to add an overall warm 
or cool tone to your photo. This is a great way to enhance an 
already perfectly processed photo with just a touch of warmth, 
without skewing any of the existing colors. By creating the filter 
from the very center of your image and dragging it out as far as 
possible, you can, in effect, add the filter to the entire image. 
Simply click the Color swatch at the bottom of the panel and 
select the filter color. Ultimately, this is a great way to add an 
extra pop of color or contrast to any photograph. 

BASIC COLOR  
AND TONE  

ENHANCEMENTS

 I added a Radial Filter and set the Color to a soft blue to cool down this photo.

 
[  D

E
V

E
L

O
P

 M
O

D
U

L
E

  ]
25



Sun haze: One of my favorite ways to use the Radial Filter is to add “sun 
haze” to my scene. You can add this to a photo that already has a good 
backlit haze to it to intensify the effect, or you can add the sun haze to 
any photo to see what you end up with. First, click-and-drag your cursor, 
starting near one of the corners of your image. Next, check the Invert 
Mask box so that the effect is applied to the inside of the radial gradient. 
You may also want to increase the Feather setting so that the edge is 
nice and soft. Then, adjust your settings until you get a nice bright and 
soft effect. For this image, I set the Temp to +17, the Exposure to +1.5, 
Highlights to –65, and Clarity and Saturation each to +20. 

26

[ 
 L

IG
H

T
R

O
O

M
 M

A
G

A
Z

IN
E

  
]



Off-center vignettes: One of the most common uses of the Radial Filter 
is to create off-center vignettes, but don’t feel like you have to limit 
your adjustments to only adjusting the exposure of your vignette. There 
are so many other ways to darken the edges and draw attention to the 
center of the photograph.

For this image, the main subject of my photo is in the lower-right corner. If 
I were to add a standard vignette, I would risk darkening the subject more 
than I’d like. Instead, I chose to go with a slightly off-center vignette to keep 
my subject nice and bright. First, I turned off Invert Mask then, instead of just 
adjusting the Exposure (set to –0.45), I also played with the Temp (+10), Tint 
(+6), Contrast (+19), and Highlights (–5).

27
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PROCESSING PHOTOS  
OF PEOPLE

The Radial Filter is a very good tool to use with portraits. Sure, you 
could use the Adjustment Brush tool, but you have an easy-to-edit, 
feathered edge to work with in a Radial Filter. Plus, people’s faces 
are oval, so it makes sense to work with a defined shape with a 
good feather to it. Here are a few ways you can use this filter when 
processing portraits.

Selective adjustments to eyes, mouth, and cheeks: The Radial Filter 
is the perfect tool to use for making selective adjustments to por-
tions of the face. The rounded shape of the gradient makes it work 
on almost any portion of the face. 

Eyes: Draw an oval shape, starting with the cursor in the middle 
of the eye. Make the shape about the size you need it, and then 
resize and rotate it afterwards to fit around the eyes perfectly. 
You’ll want it to cover the eyes from the bottom eyelashes to 
the top eyelashes, and just outside of the eyeball portion from 
left-to-right. To move just one side of the Radial Filter, hold the 
Option (PC: Alt) key while dragging one of the control handles. 
If there’s excess darkening around the eyes you may want to 
slightly increase the size. Check the Invert Mask box, and then 
play with the sliders to increase the Contrast, Clarity, and also 
brighten the colored portion of the eyes with the Saturation and 
Shadows sliders.

28
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Mouth: Draw a skinny oval shape over the lips, and cen-
ter it over the mouth. Rotate it and increase the size so 
that it fits just around the lips. Then, check the Invert 
Mask box and increase the Saturation and Clarity sliders 
to see how it looks. For this image, I also added a pink 
color with the Color adjustment, as well as decreased the 
Highlights and increased the Temp to make the lips stand 
out a bit. Note: This will usually only work best in photos 
with a closed mouth. 

Cheeks: The Radial Filter is a quick way to add a hint of color 
to the cheeks. Just create an oval shape, invert the mask, and 
then rotate it so that it sits high on the cheekbones. Then, 
add a pink hue from the Color setting, and increase the 
Feather (I set mine to +76). For this image, I also decreased 
the Exposure (–0.41) to darken the cheekbones slightly. 
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ALL IMAGES BY NICOLE S. YOUNG

Tip: Once you’ve made your adjustments to each section of the 
face, be sure to save it as a Radial Filter preset. To do this, click 
the Effect drop-down menu at the top of the panel, choose Save 
Current Settings as New Preset, and give it a name. Then, in the 
future, when applying a new Radial Filter, choose the preset from 
the list to apply those same settings to other images. 

Bringing attention to the face: When we look at a photo, our eyes 
tend to see the brightest portion of the image first. Because of this, we 
will likely want the face in a portrait to be the element that stands out 
the most. By using a Radial Filter, you can add a vignette that allows 
you to focus the attention on the face.

To do this, first add your filter, placing the point in the center of the face. 
Rotate and resize it so that it sits just outside of the face, then make 
adjustments to the Exposure and Shadows (I set my Exposure to –0.55 
and the Shadows to –15), and any other setting you think will work. 
This adjustment, regardless of how subtle it is, can be a good way to 
direct the attention of the image more toward the face. ■
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ONE OF THE HURDLES WE ALWAYS FACE WHEN 

SHOOTING OUTDOORS IS BALANCING BRIGHT 

SKIES WITH DARKER FOREGROUNDS. WHILE 

OUR EYES SEE LOTS OF DETAIL IN THE SHAD-

OWS AND HIGHLIGHTS, WE USUALLY HAVE TO 

FORCE OUR CAMERAS TO MAKE A CHOICE. DO 

WE EXPOSE FOR THE FOREGROUND OR THE 

SKY? WELL, WITH A FEW FEATURES IN LIGHT-

ROOM (AND SOME HELP WITH PHOTOSHOP), 

YOU CAN USE SMART OBJECTS TO GET THE 

BEST OF BOTH WORLDS BY PROCESSING THE 

SAME PHOTO TWICE, ONCE FOR EACH KEY 

AREA IN THE IMAGE. 

DOUBLE  
PROCESSING
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ALL PHOTOS BY MATT KLOSKOWSKI
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LIGHTROOM
 PLUG-INS

YOU’VE BEEN SHOOTING FOR A WHILE NOW, 

AND YOU HAVE SOME REALLY GREAT PHO-

TOS IN YOUR PORTFOLIO. MAYBE YOU’VE 

EVEN SOLD A FEW. NOW, YOU NEED A WEB-

SITE WHERE YOU CAN MARKET AND SELL 

YOUR WORK, BUT IT’S COMPLICATED, RIGHT? 

MANY PHOTOGRAPHERS DON’T HAVE THE 

SKILLS NECESSARY TO BUILD A PROFES-

SIONAL WEBSITE. AND THEN THERE’S PRINT-

ING, AND SHIPPING, AND MARKETING, NOT 

TO MENTION PREPARING AND PROCESSING 

ORDERS. THE JOB FEELS SO OVERWHELM-

ING THAT MOST PHOTOGRAPHERS PUT 

IT OFF AS LONG AS THEY CAN. THE GOOD 

NEWS IS THAT IT DOESN’T HAVE TO BE COM-

PLICATED ANYMORE.

SMUGMUG AND 
THE PUBLISH 

SERVICES PANEL

VA R I N A  P A T E L

MAXIMUM WORKFLOW:
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SmugMug offers a completely customizable photo-sharing and 
professional sales-management system for photographers, and 
they’ve just gone live with a much-anticipated update. The new 
SmugMug is the perfect solution, and Lightroom can help you get 
it done. 

Getting your photos from your computer to the Web is quick and 
easy, and you can do it right from the Publish Services panel in the 
Library module in Lightroom. A few clicks of a button will send 
your images off to Facebook, Flickr, or Adobe’s own Behance, and 
more plug-ins are available through Adobe Exchange online. Let’s 
begin by setting up the SmugMug plug-in and getting familiar with 
the Publish Services panel. Then, I’ll offer some tips for coordinat-
ing your workflow between Lightroom and SmugMug for even 
better results.

The brand-new SmugMug offers customizable photo sharing and sales management
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DOWNLOAD AND CONFIGURE  
THE SMUGMUG PLUG-IN 

The SmugMug plug-in isn’t included in the Lightroom 5 Pub-
lish Services panel, but you can download it by clicking the Find 
More Services Online button at the bottom of the panel. You’ll 
be taken to the Lightroom section of the Adobe Exchange web-
site. Click the Download button for the SmugMug plug-in, sign 
into your Adobe account, and your download will begin shortly. 
Back in Lightroom, choose File>Plug-in Manager, click the Add 
button at the bottom left, navigate to the SmugMug plug-in, 
and click the Add Plug-in button. Click Done in the Lightroom 
Plug-in Manager. The SmugMug tab will appear in the Publish 
Services panel. 

Click Set Up on the new SmugMug tab in the Publish Services 
panel to open the Lightroom Publishing Manager. If you already 
have an account, you’ll need to authorize Lightroom to access 
it, add photos, and create and modify galleries. If you’re new to 
SmugMug, you’ll be asked to enter an email address and choose 
a username and password. SmugMug will provide a free 14-day 
trial, so you can learn the ropes before purchasing. Once your 
account is authorized, you can return to the Lightroom Publish-
ing Manager and choose the settings that work best for you. 

You have tons of great options here, but don’t feel overwhelmed. 
Defaults are already set to the recommended settings for most 
users, and you can always return to make changes down the 
road by double-clicking the SmugMug tab in the Publish Services 
panel. Each service has its own options dialog, so you can have 
different settings for each of the publishing plug-ins you use. 
Just select the service you want to manage from the list on the 
left in the Lightroom Publishing Manager, and use the collaps-
ible menus on the right to make your selections. When you’re 
happy with your settings, click Save, and Lightroom will synchro-
nize with your SmugMug account. You’ll see any existing gal-
leries you’ve already created in SmugMug appear in the Publish 
Services menu.
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SET UP YOUR  
GALLERY

Drag-and-drop to add photos to your collections

The next step is to set up your gallery structure. Right-click on the 
SmugMug Publish Services tab, and select Create Gallery from 
the menu to build a new gallery. Choose a Name for your gallery, 
and assign it to a Set. If you’ve already defined Quick Settings in 
your SmugMug account, you can apply those here. Quick Set-
tings allow you to save gallery presets so you can quickly config-
ure new galleries as you create them. If you want more options, 
select Advanced Settings in the Quick Settings drop-down menu. 
If you want the Advanced Settings to always appear in the Create 
Gallery dialog, select the Show Advanced Gallery Dialog option in 
the Lightroom Publishing Manager. Publish Services also lets you 
create folders, edit and delete folders or galleries, and nest folders 
within your hierarchy to help with organization. 

You can place pictures in your new gallery by dragging-and-
dropping, but I prefer to save time by Right-clicking on the 
folder and choosing Set as Target Collection. As you browse 
through your photos, press the B key to automatically add a 
selected image to the targeted folder. When you’re finished, it’s 
a good idea to turn off the Set as Target Collection option so 
you don’t accidentally add images to that folder later. If you 
don’t set a specific folder as a Target Collection, pressing the B 
key will put images in the default Quick Collection folder in the 
Catalog panel. 
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Select a photo and press the B key to send a photo to the Target Collection

The SmugMug plug-in offers another great option to help 
you find files that you might want to include in your portfolio. 
Smart Galleries will automatically pull files from your catalogs 
based upon rules you define. It’s important to realize that these 
Smart Galleries will pull images from your Lightroom catalogs. 
They are not the same as SmugMug Smart Galleries, which pull 
files from your online SmugMug galleries, but they work in a 
similar way.

Smart Galleries work particularly well for me because I always 
keyword my photos, and I’m consistent about labeling my 
favorite photographs with a 5-star rating. To create a Smart 
Gallery, Right-click on the SmugMug Publish Services tab and 
choose Create Smart Gallery. You can set up the gallery rules 
in the Create Smart Gallery dialog that appears. I created 
a Smart Gallery for my nature portfolio using three simple 
rules: I asked Lightroom to look for 5-star TIFF files that con-
tained the keywords “mountain” or “mountains.” The results 
were pretty good. Although there were some repeated images, 
I quickly removed the ones I didn’t want by reducing the star rat-
ing or removing an incorrect keyword. 
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Of course, you can always modify Smart Gallery rules to help 
narrow the selection. Right-click on the appropriate gallery and 
choose Edit Smart Gallery from the list. I love the Smart Gallery 
feature because it continues to add new photographs automati-
cally over time, as long as the parameters are met. I can review 
them and publish to my SmugMug site on an ongoing basis. 

When your gallery is ready, send your photos off to your SmugMug 
site by clicking the Publish button at the top right of the Library 
module. You can monitor the progress of the update in the upper-
left corner of the Lightroom interface. You’ll also notice that the 
center panel of the Library module splits to show photos that are 
ready to publish at the top, and already published photos below.

That’s all it takes! Once the upload is complete, your photographs 
will be visible on your personal SmugMug website. You can log 
into your SmugMug account to set up your price list and shipping 
details, and you can make your site look amazing with SmugMug’s 
recently updated customization tools.

Lightroom keeps you up to date on progress during updates
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TIPS FOR  
POWER USERS

Sync photos in the Favorites folder to view and edit the shots your clients really love

Resize to Fit and Proof Delay
What if you have a thousand photos to upload from a recent event? 
Uploading large files would take hours, and many of those files 
might never be printed. Instead, use the Resize to Fit feature in the 
Image Sizing section of the Lightroom Publishing Manager to scale 
the images down for Web display. When I do this, I also set a Proof 
Delay in my Gallery settings. This feature allows me a few days to 
prepare my original files for printing. When they’re ready, I simply 
click the Publish button again, and Lightroom will replace the exist-
ing files on my SmugMug site with full-resolution files ready for print. 
Together, these options can save you countless hours since there’s no 
need to prepare images for print unless someone places an order.

Playing Favorites
If you’re working with clients and you have a SmugMug Pro Busi-
ness Account, you can use Events to help simplify your work-
flow. When you create an Event on the SmugMug site (Account 
Settings>Business>Making Money), you can assign a password, if 
necessary, and connect associated galleries. When guests visit the 

event galleries, they can register and select their favorite photos. 
Then, you can sync your gallery hierarchy in Lightroom Publish-
ing Manager (turn on the Sync Hierarchy option in the Smug-
Mug Settings section). When you sync the photos in the Favorites 
folder (Right-click, select Edit Gallery, and turn on the Sync Photos 
option), you’ll be able to see all their favorites in one place. Wed-
ding and event photographers love this functionality, and it works 
well for planning wedding books and photo albums, too.
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Synchronizing Photos and Resolving Conflicts
Syncing your gallery hierarchy takes just a few seconds, but if you 
have thousands of images, you may find that syncing your photos 
can take a long time. It’s best to synchronize photos one gallery at 
a time. Even so, Lightroom may find some conflicts as it compares 
different versions of the same file. Luckily, Publish Services makes 
it easy to resolve those conflicts. Check the specs of the images in 
the Conflict Resolution dialog and choose the correct match. You 
may need to resolve conflicts if you update photos, change image 
sizes, or adjust metadata. Also, remember that removing a file 
from your SmugMug gallery in Lightroom will delete it from your 
SmugMug site the next time you publish that gallery. 

Publishing Manager
When you add titles or update keywords, you don’t need to upload 
your image file again. Instead, open the Lightroom Publishing Manager 
and select Metadata Only under the Republishing tab. Once again, 
this is particularly useful when you’re working with a large number of 
files. Lightroom will quickly replace the metadata you’ve changed, but 
it won’t waste time updating the image files themselves. 

For years, I made and sold prints on my own. I handled postprocess-
ing, upsizing, sharpening, color calibration, and printing in my home 
office. I’d send orders for really large canvases to a local printmaker. As 
time passed, my print sales increased. I was struggling to meet orders 
on time, and unwilling to compromise on quality. SmugMug was the 
solution. I no longer have to worry about all the tasks associated with 
selling prints—from handling orders to printing and shipping—and 
my online galleries are always ready for my clients. SmugMug lets me 
make the most of my time, and the Lightroom Publish Services panel 
makes the process even more efficient. n

SmugMug handles my print sales so I can spend more time shooting
ALL PHOTOS BY VARINA PATEL
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8 BIT,  16 BIT, 
32 BIT: WHAT DOES THIS  

MEAN FOR DIGITAL  
PHOTOGRAPHERS?
 BY LAURA SHOE
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YOU MAY BE PHOTOGRAPHING IN RAW RATHER THAN JPEG BECAUSE YOU KNOW THAT RAW FILES ARE UNPROCESSED, 

GIVING YOU MORE FLEXIBILITY, AND THAT THEY CONTAIN MORE INFORMATION. BUT HOW DO THEY CONTAIN MORE 

INFORMATION? AMONG OTHER THINGS, DIGITAL PHOTOGRAPHY RAW FILES ARE CAPTURED AT A HIGHER BIT DEPTH—

DEPENDING ON THE CAMERA, 12, 14, OR 16 BIT, COMPARED TO 8 BIT FOR JPEGS. WHETHER 12, 14, OR 16, THESE HIGHER 

BIT-DEPTH FILES POTENTIALLY CONTAIN MUCH MORE INFORMATION THAN 8-BIT FILES.                   

Laura Shoe is an Adobe Community Professional and Adobe Certified Expert in Photoshop Lightroom, and writes a popular Lightroom 
blog at www.laurashoe.com. She is also the author of the widely acclaimed Lightroom Workshops on Video, The Fundamentals & Beyond 
and Producing Great Output. She has taught Lightroom and Photoshop for Rocky Mountain School of Photography, creativeLIVE, Pho-
tographic Center Northwest, and others, and lectures regularly. She particularly enjoys helping photographers to understand and get 
comfortable with technical topics so that they can truly enjoy digital postprocessing. Laura worked for almost 20 years in the corporate 
world before pursuing her passion of photography.
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W H AT  I S  B I T  D E PT H ?
For each pixel in your image, the tonal value (or brightness) of the scene you’re photo-
graphing is stored in the image file on your memory card, along with the color. Com-
puter files store information in sequences of zeros and ones (binary). Bit depth refers to 
how many digits are used to store the tonal information. Imagine if your camera used a 
bit depth of 1. You’d have one digit to store how dark each piece of the scene was, the 
only possible values would be 0 and 1, and the only two tones that could be represented 
are black and white. This image has very little detail since it contains no shades of gray.  

If the file had a bit depth of 2, there would be two digits to store each tone, and the 
four values of 00, 01, 10, and 11 would be possible, so the image could have black, 
dark gray, light gray, and white. 

Notice that we have gained some detail, but that the image is still very choppy. In the 
histogram for this image, we see huge gaps between the tones, confirming this chop-
piness, or posterization. (The histogram is a graph of the tones in an image, going 
from pure black on the left edge to pure white on the right edge.)

BIT DEPTH REFERS TO 

HOW MANY DIGITS ARE 

USED TO STORE THE 

TONAL INFORMATION.
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Let’s jump to a file with a bit depth of 5, which allows 25, or 32 possible values from 
00000 to 11111. We gain a lot of detail, but there’s still obvious posterization, or band-
ing, in the sky. The histogram supports this.

Now let’s look at an 8-bit image, which allows 28, or 256 values, and is what a 
JPEG supports. Eight bits shows the full detail of the scene with no visible poster-
ization, even when viewed at full size, and the histogram looks much better.  
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So why not stop here with 8 bits and 256 tones? The problem is that as soon as you 
start enhancing your image, you start compressing and expanding the tonal range. 
This creates choppiness in the histogram and potentially, visible posterization in your 
image. To show this, I made two adjustments to the photo: I brightened it and added 
contrast. Notice how this introduced gaps in the histogram. 

I’ve included these histogram screenshots, captured from Photoshop, so that you can 
better understand bit depth and its implications, but in the end, gaps in the histogram 
are not what matters. In fact, the histogram in Lightroom, unlike Photoshop, won’t 
show you these gaps because, for various reasons, it smooths out the data. Visible 
issues in your photo are what matters. With the relatively small adjustments to the 
photo above, there’s no banding, even when I zoom to 1:1. In practice, you’ll find that 
banding, as well as color shifts, are most likely to occur when you start with a photo 
that has a narrow tonal range and expand it greatly (i.e., with a very narrow histogram 
that you stretch out greatly with very heavy editing). You’ll find that areas in your 
photo with smooth gradations in tones, such as skies and skin, are most vulnerable.

You’re already doing one thing that 
can help you avoid these issues: edit-
ing your JPEGs in Lightroom, which 
does a better job of blending tones 
in these circumstances than Photo-
shop. The other thing you can do to 
get the highest possible quality is to 
capture your image in a higher bit-
depth file so that you have more data 
to work with.

VISIBLE ISSUES 

IN YOUR 

PHOTO ARE 

WHAT MATTERS.
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W H AT ’S  T H E 

D I F F E R E N C E 

W I T H  A  H I G H E R 

B I T- D E PT H  F I L E ?

Twelve-bit files have more than 4,000 tones, and 14-bit files have more 
than 16,000, compared to only 256 for JPEGs. Higher bit-depth files 
also potentially have a much larger number of colors: an 8-bit JPEG can 
represent around 16 million colors, whereas a high bit-depth file can 
represent more than 68 billion. With vastly more tones and colors, your 
photos will hold together, even under the heaviest editing. Here’s the 
Photoshop histogram from the 12-bit version of the car photo with the 
brightening and increased contrast

To have this additional editing headroom, you need to capture a high 
bit-depth image (i.e., a RAW file, not a JPEG), and you have to edit 
it as a high bit-depth file. While you’re working in Lightroom, your 
work on the RAW file will automatically be in 16 bit (standardized 
to accommodate 12, 14, and 16 bits). When you move a file from 
Lightroom to Photoshop, you need to ensure that the Photoshop file 
stays in 16 bit instead of being compressed into an 8-bit file. To do 
this, in Lightroom, choose Lightroom (PC: Edit)>Preferences, click the 
External Editing tab, set File Format to PSD or TIFF, and set Bit Depth 
to 16 bits/component.

The downside to higher bit-depth files is larger file sizes. All else 
being equal, a 16-bit image file is twice as big as an 8-bit image file, 
but large memory cards and hard drives are so much cheaper these 
days than they used to be.

Histogram from 12-bit version  
with lightening and contrast boost
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W H Y  D O  W E  
N E E D  32- B I T 

F I L ES  FO R  H D R?

Sixteen bits offer more than enough values to represent all potential 
tones, from the deepest blacks to the brightest whites, that our cam-
eras can capture in one image; that we need for editing headroom; 
and that our monitors and printers can reproduce. However, 32 bits 
are needed to represent the full range of tones that we can actually 
see, and that we can capture using multiple exposures. Merge to HDR 
Pro in Photoshop and other HDR programs can combine the full range 
of tones from these multiple exposures into a 32-bit result. 

Since our monitors and printers can’t reproduce this complete range, 
we then use tone mapping to decide how these tones are going to 
be condensed into the range that a lower bit-depth file can handle 
and that our monitors and printers can reproduce. You can do this 
tone mapping in your HDR program and then save your 16-bit file for 
further editing in Lightroom, but the tone mapping controls in these 
programs, including Photoshop, are complicated. Starting with Light-
room 4.1, there’s a much easier way (as long as you’re not after an 
over-the-top, faux-HDR look). Simply save your 32-bit file as a TIFF in 
your HDR program, and then do the tone mapping in Lightroom using 
the Basic panel in the Develop module. 

When you first view your 32-bit file in Lightroom, most likely your 
highlights will still look blown out, and your shadow areas will still be 
too dark. This doesn’t mean that the data isn’t there from the multiple 
exposures; it just confirms what I just explained—that your monitor 
can’t show you the full range of tones. Adjust the Exposure, High-
lights, Shadows, Whites, and Blacks to darken the highlights, brighten 
the shadows, etc. (Note: When you’re working with a 32-bit file, Light-
room increases the Exposure range from +/– 5 to +/– 10 to give you 
more editing flexibility.) You can also turn to additional tools, such as 
the Tone Curve and the Adjustment Brush. n

Multiple exposures captured to merge in Merge to HDR Pro in Photoshop
ALL PHOTOS BY LAURA SHOE
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          THE 
BOOK

MODULE
IN LIGHTROOM 5, ADOBE ADDED AUTO

MATIC PAGE NUMBERING FOR YOUR 

PHOTO BOOKS, ENABLING YOU TO CON

TROL THE POSITION OF THE PAGE NUM

BERS ON THE PAGE, AND GIVING YOU 

PRETTY GOOD CONTROL OVER FORMAT

TING (FONT, SIZE, ETC.), AS WELL. YOU 

CAN EVEN CHOOSE ON WHICH PAGE THE 

AUTOMATIC PAGE NUMBERING BEGINS. 

WE’LL ALSO LOOK AT HIDING THE PAGE 

NUMBER ON BLANK PAGES. 

AUTOMATIC PAGE 
NUMBERING

B Y  S C O T T  K E L B Y

CREATIVE OUTPUT:
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STEP TWO

STEP ONE To turn on auto page numbering, go to the Page panel in the 
right-side panels area of the Book module, and turn on the Page 
Numbers checkbox. By default it places those page numbers in 
the standard position in the bottom-left corner (for left pages) 
and bottom right for right pages (as seen here).

You can change the position of the page numbers using the 
pop-up menu to the right of the checkbox in the Page panel. 
To move page numbers from the outside corners to the center 
of the page, choose Top and they will be centered at the top  
of the page (as you see here), or Bottom to have them centered 
on the bottom. So why not just name these “Top Center” or 
“Bottom Center”? Because then it would be too obvious (don’t 
get me started). Anyway, you can also choose to have your 
page numbers appear on the outside edges of the page by 
choosing Side. 
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STEP THREE

STEP FOUR

For our book, we’ll choose Bottom (centered). Now, for this series 
of images I created where the sky is white, the image on the right 
page is kind of floating there on a white background, but when  
I go to the Background panel, turn off Apply Background Globally, 
check the Background Color box, and change the background 
to black, the page number on the right page disappears. That’s 
because the page numbering’s default color is black, and of course 
you can’t see black text on a black page, but we can change that. 

To change the color of the number on the right page, click directly 
on the spot where the number would normally appear (it highlights 
that area for you). Now go to the Type panel, click on the black 
Character color swatch to bring up the Character color picker, and 
click on white to change the page number so it appears in white. 
That works great for the right page, but now take a look at the left 
page—it’s now white, too. That’s because, by default, whichever 
color you choose is applied to the text on every page, but we can 
change that so we have control over individual pages (which is what 
I find I need most of the time in book layouts). 
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STEP FIVE To turn off this “make all the numbers the same color” feature, Right-
click directly on the page number that you want to change, and from 
the pop-up menu that appears, uncheck Apply Page Number Style 
Globally. Now you can control that page number’s color individually 
without affecting any of the other pages. Note that the Apply Page 
Number Style Globally will still be turned on for all the other pages. 

Now you can highlight that white number on the left page, go 
to the Type panel, click the color swatch, and choose black for 
the color. The number on the right page will remain in white (as 
seen here). Note: If you have a large book project and are chang-
ing the background color of only a few pages, turn off the Apply 
Page Number Style Globally feature first for each of those pages. 
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STEP SIX Of course, you can do more type formatting other than just chang-
ing the color. If you click on a page number and go over to the Type 
panel, you can format your type pretty much any way you want. In 
this case, I changed the font to Trajan Pro, but once I did that, the 
font size looked too big (the default size was 18 pt), so I lowered the 
size to 12 pt. 

Tip: If I had turned off the Apply Page Number Style Globally feature for 
some of the pages in the book, I now have to go and style each of those 
pages individually, so I’d have to go to each of those pages and change 
the font to Trajan Pro and lower the point size to 12 pt. Here’s a timesav-
ing tip to keep you from having to do that: Choose your font and size 
first, before you turn off the Apply Page Number Style Globally feature 
for any of the pages (even if you can’t see some of the page numbers 
at first). Then, once you’re happy with your font and size choices, turn 
it off for the pages where you need to change the color.
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If you have a blank page in your book (maybe a left-hand page) and 
you don’t want it to have a printed page number, Right-click on the 
number on the blank page, and choose Hide Page Number from the 
pop-up menu that appears. 

Besides customizing the look of the page numbers, you can also 
choose which page the numbering starts on. For example, if the 
first page of your photo book is blank (so the images or opening 
story begin on the right page), you can have that right page become 
page 1 by Right-clicking on that page number and choosing Start 
Page Number from the pop-up menu that appears. 

There you have it. There’s still more cool stuff to learn about the Book 
module, so we’ll see you back here next issue. n

STEP SEVEN

STEP EIGHT

ALL PHOTOS BY SCOTT KELBY
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AND 
TIPS 

B Y  S E Á N  D U G G A N

TRICKSUNIVERSAL 
SHORTCUT FOR 

THE PRINT  
MODULE

THE SHORTCUT TO SWITCH TO THE 

PRINT MODULE IS THE SAME KEY-

BOARD SHORTCUT YOU’D USE TO 

PRINT A FILE IN MOST ANY OTHER 

SOFTWARE YOU’VE EVER USED: 

PRESS COMMAND-P (PC: CTRL-P).
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APPLY KEYWORDS  
ON IMPORT 

START BROAD, THEN 
NARROW THE FOCUS  

BATCH APPLY  
KEYWORDS  

IN GRID VIEW  

Choose File>Import Photos 
and Video. In the Import dia-
log, you can add and apply 
keywords in the Apply Dur-
ing Import panel on the right 
side of the dialog. There are 
likely to be only a few key-
words that will pertain to all 
of the images you’re import-
ing from a single card, such 
as those that reference a 
general location or an event, 
but any information applied here can be useful in locating photos 
down the road. 

When the images have been imported, you can apply more image-
specific keywords. Let’s say you have a card full of images taken at 
several locations in Iceland. You would have applied the basic loca-
tion keyword of “Iceland” upon import. Now you’ll apply more 
specific location keywords and any other identifiers to specific 
groups of the images—images that have something more specific 
in common. The idea is to apply a keyword to as many images as 
you can before moving on to the next group of images and the 
next keyword.

Press (G) to make sure you’re in Grid view. Select all the thumbnails 
that are from the same place (e.g., Reykjavík), press Command-K 
(PC: Ctrl-K) to activate the keyword entry field in the Keywording 
panel, then enter the relevant keyword. A single keyword entry 
will be applied to all selected images. Move on to the next batch 
of images taken at a different location. For some locations you 
may be able to enter several keywords at once to both identify the 
location and describe some of its primary characteristics, such as 
Jökulsárlón, glacial lagoon, icebergs, and ice. Once the different 
locations have been keyworded, you can apply any other relevant 
keywords that might help you both identify and find the images 
later, such as waterfall, geothermal, lava field, glacier, Arctic tern, 
puffin, etc.
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SYNC DEVELOP  
SETTINGS ACROSS  

MULTIPLE SHOTS

USE COLLECTIONS  
TO REFINE FOR  
LAB ORDERING

If you have a series of shots that could all benefit from the same adjust-
ment, such as family group portraits, or images made under the less-
than-ideal lighting of a reception hall, you can adjust one and then 
apply those settings to all the other shots that need the same correc-
tion. First, choose a shot that is representative of all of the images that 
need correcting and make the necessary global adjustments in the 
Develop module. Then, with that image selected, select the other shots 
to be corrected in the Filmstrip (for shots that are contiguous, Shift-click 
on the last shot in the sequence; for noncontiguous shots, Command-
click [PC: Ctrl-click] on the other images you want to select). The initial 
photo you adjusted should have a slightly brighter highlight color on its 
thumbnail, indicating it is the source for any settings that will be applied 
to the other shots. Click the Sync button at the bottom of the right side 
panels area (it changes from Previous to Sync when multiple images are 
selected). In the Synchronize Settings dialog that appears, choose the 
settings you want to apply to all of the selected images. Remember that 
you only want to apply settings that will work with all of the images, 
such as white balance and basic tonal adjustments. 

When the time comes to create 
groups of images that will be used 
for ordering prints or albums from 
a photo lab, rather than making 
copies of the files, take advantage 
of collections. For instance, you 
might have a general collection set 
for that specific event and inside 
that you could have collections for 
specific purposes, such as your favorites, the set you will show to the cli-
ent, the client’s picks, and the shots for the album. The same image file 
can be a part of several collections, yet the original file is never duplicated. 

When it’s time to generate high-quality JPEGs to send to the lab, use 
the File>Export feature. If it makes sense for your own archiving system 
to create a separate folder of those exported JPEGs to be stored in 
the main client folder, there’s an Add to This Catalog checkbox in the 
Export Location section of the Export dialog that will allow you to add 
these exported files back into your Lightroom catalog. n

ALL PHOTOS BY SEÁN DUGGAN
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ALL PHOTOS BY CHRIS ORWIG 

Chris Orwig is a celebrated photographer, author, and educator who brings authenticity and enthusiasm to 

all that he does. Chris has authored more than 50 online courses on the topics of photography, Photoshop, 

and Lightroom at Lynda.com.

CHRIS  
ORWIG  
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Chris’s most recent book projects include, Visual Poetry: A Creative Guide for Making Engaging Digital Photographs and People Pictures:  

30 Exercises for Creating Authentic Photographs. 



Chris is based in Santa Barbara, California, where he lives with his wife, three daughters, six chickens, and their beloved Golden Retriever, 

Daisy. For more information about his work or to keep in touch, visit ChrisOrwig.com.
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